MRI data analysis in FSL

A YNiC Tutorial*

Much of the content within this document is taken directly from FSL’s online tutorials (thank you FMRIB). This has then been amended to suit YNiC’s requirements. 

Tutorial 1 – fMRI data analysis using FEAT – single subject analysis

Tutorial 2 – fMRI data analysis using FEAT – within group (or between subjects) analysis 

Tutorial 3 – fMRI data analysis using FEAT – between group analysis

Tutorial 4 – fMRI data analysis using FEAT – advanced tricks ad techniques for efficient interrogation of initial results

· Viewing ‘raw’ timeseries data

· Creating region of interest masks (manually)

· Re-thresholding statistics

· Using Featquery

· Moving between low, standard and high-resolution spaces – ApplyXFM_gui

Tutorial 5 – model-free fMRI data analysis using FEAT – ICA with MELODIC 

Tutorial 3 – Interacting with DV3D – Part 1:moving, slicing and brightening

Tutorial 4 – Interacting with DV3D – Part 2: hiding, auto-viewing, resetting

Tutorial 5 – Orthogonal viewing window

Tutorial 6 – MRI - Loading surface files

Tutorial 1 – fMRI data analysis using FEAT – within subject analysis

________________________________________________________________

The data modelling which FEAT uses is based on general linear modelling (GLM), otherwise known as multiple regression. It allows you to describe the experimental design; then a model is created that should fit the data, telling you where the brain has activated in response to the stimuli. 

In FEAT, the GLM method used on first-level (time-series) data is known as FILM (FMRIB's Improved Linear Model). FILM uses a robust and accurate nonparametric estimation of time series autocorrelation to prewhiten each voxel's time series; this gives improved estimation efficiency compared with methods that do not pre-whiten.

In this tutorial we will run through an example single person analysis. 

The dataset /scratch/groups/tutorials/mri/fsl_course_data/fmri/av/fmri.nii.gz
is from an audio-visual experiment. Auditory stimulation was applied as an alternating ``boxcar'' with 45s-on-45s-off and visual stimulation was applied as an alternating ``boxcar'' with 30s-on-30s-off. The TR is 3 seconds. 

Starting FEAT and loading data

Lets get started – Launch fsl:
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Start an x-term session

At the command line type
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> fsl &

The main FSL program options GUI will load
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Click on the button labelled 

FEAT FMRI Analysis
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The main FEAT window will launch.

A few things to note whilst you are using this program:

· The GUI is made up of tabs which we will work through sequentially to set up the analysis. The order is

· Data – selecting the dataset and 

· Pre-stats

· Stats

· Post-stats

· Registration

· Hovering your mouse over an item will give you some information about what that item does. Try it.
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Click Select 4D data and select /

/scratch/groups/tutorials/mri/fsl_course_data/fmri/av/fmri.nii.gz
(don't just type " fmri.nii.gz " in the file select popup or you probably won't end up setting the full pathname; use the file-select icon on the right to select the input data).

Set the output directory for the analysis as 

~/scratch/my_feat_tutorial
Important checkpoint – once you have provided the dataset FEAT should automatically knows how many time points (volumes) you have. The Total volumes indicator should change automaticcal from 0 to this number. If your TR (time between 3D volumes) is not 3s, change it (it is right for this dataset). If Total volumes does not automatically update there is a problem!

Set the Delete volumes option to 0.

These represent the dummy volumes that are acquired at the start of any fMRI acquisition The is because the scanner need’s to ‘get up to temperature’ when it firsts starts acquiring date i.e. steady-state imaging is not reached for typically two or three volumes. Here at YNiC these volumes are automatically discarded from the dataset for you so they have already been removed (hence set the value to remove 0 volumes).

Set the High pass filter cutoff to 90. 

It is best to set this to the maximum stimulation period (in this case 45*2=90secs); the highpass filter used in FEAT has quite a slow roll-off above the cutoff frequency, so setting this to the 90s period time is fine.
Setting up data pre-processing

Press the Pre-stats tab to look at the pre-processing steps.
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All the default pre-processing steps are fine for this dataset. The settings should be:

Motion correction:  Select MCFLIRT

You will normally want to apply Motion correction; this attempts to remove the effect of subject head motion during the experiment. MCFLIRT uses FLIRT (FMRIB's Linear Registration Tool) tuned to the problem of FMRI motion correction, applying rigid-body transformations.

B0 unwarping: un-ticked (not selected)

B0 unwarping is carried out using FUGUE. Here you need to enter the B0 fieldmap images which should be created before you run FEAT and usually require site/scanner/sequence specific processing. See the PRELUDE/FUGUE documentation for more information on creating these images. The two images that are required are (1) a fieldmap image which must have units of rad/s, and (2) a registered magnitude image (this is usually a standard magnitude-only reconstructed image from the fieldmap sequence data). Next you need to enter the EPI Dwell time in milliseconds (this is the time between echoes in successive k-space lines - often also known as the echo spacing for EPI) and EPI TE (echo time) also in milliseconds. These two values relate to your FMRI EPI data, not the fieldmap data. You also need to specify the Unwarp direction, which is the phase-encoding direction of your FMRI EPI data. The sign of this direction will depend on both the sign of the phase encode blips in the EPI sequence and on the sign of the fieldmap. As it can be difficult to predict this sign when using a particular site/scanner/sequence for the first time, it is usual to try both positive and negative values in turn and see which gives better undistortion (the wrong sign will increase the amount of distortion rather than decrease it). Finally, you need to specify a % Signal loss threshold. This determines where the signal loss in the EPI is too great for registration to get a good match between the EPI data and other images. Areas where the % signal loss in the EPI exceeds this threshold will get masked out of the registration process between the EPI and the fieldmap and structural images. If you are running both motion correction and B0 unwarping, the motion correction resampling does not get applied at the same time as the motion estimation; instead the motion correction gets applied simultaneously with the application of the B0 unwarping, in order to minimise interpolation-related image blurring. Once you have run FEAT you should definitely check the unwarping report (click on the mini-movie, shown in the main FEAT report page, that flicks between distorted and undistorted versions of example_func). In particular you should check that it looks like the unwarping has occurred in the correct direction (and change the unwarp direction and/or sign if it is not).

Slice timing correction : Select None

NB at YNiC you would normally select BOTTOM-UP as our default data acquisition protocol for fMRI data is this. 

Slice timing correction corrects each voxel's time-series for the fact that later processing assumes that all slices were acquired exactly half-way through the relevant volume's acquisition time (TR), whereas in fact each slice is taken at slightly different times. Slice timing correction works by using (Hanning-windowed) sinc interpolation to shift each time-series by an appropriate fraction of a TR relative to the middle of the TR period. It is necessary to know in what order the slices were acquired and set the appropriate option here. If slices were acquired from the bottom of the brain to the top select Regular up. If slices were acquired from the top of the brain to the bottom select Regular down. If the slices were acquired with interleaved order (0, 2, 4 ... 1, 3, 5 ...) then choose the Interleaved option. If slices were not acquired in regular order you will need to use a slice order file or a slice timings file. If a slice order file is to be used, create a text file with a single number on each line, where the first line states which slice was acquired first, the second line states which slice was acquired second, etc. The first slice is numbered 1 not 0. If a slice timings file is to be used, put one value (ie for each slice) on each line of a text file. The units are in TRs, with 0.5 corresponding to no shift. Therefore a sensible range of values will be between 0 and 1.

BET brain extraction: Tick this option

By default BET brain extraction is applied to create a brain mask from the first volume in the FMRI data. This is normally better than simple intensity-based thresholding for getting rid of unwanted voxels in FMRI data. Note that here, BET is setup to run in a quite liberal way so that there is very little danger of removing valid brain voxels. If the field-of-view of the image (in any direction) is less than 30mm then BET is turned off by default. Note that, with respect to any structural image(s) used in FEAT registration, you need to have already run BET on those before running FEAT.

Spatial smoothing FWHM (mm) : Set to 5mm

Spatial smoothing is carried out on each volume of the FMRI data set separately. This is intended to reduce noise without reducing valid activation; this is successful as long as the underlying activation area is larger than the extent of the smoothing. Thus if you are looking for very small activation areas then you should maybe reduce smoothing from the default of 5mm, and if you are looking for larger areas, you can increase it, maybe to 10 or even 15mm. To turn off spatial smoothing simply set FWHM to 0.

Intensity normalisation: un-ticked (not selected)  

This option forces every FMRI volume to have the same mean intensity. For each volume it calculates the mean intensity and then scales the intensity across the whole volume so that the global mean becomes a preset constant. This step is normally discouraged - hence is turned off by default. When this step is not carried out, the whole 4D data set is still normalised by a single scaling factor ("grand mean scaling") - each volume is scaled by the same amount. This is so that higher-level analyses are valid.

Perfusion subtraction: un-ticked (not selected)   

Perfusion subtraction is a pre-processing step for perfusion FMRI (as opposed to normal BOLD FMRI) data. It subtracts even from odd timepoints in order to convert tag-control alternating timepoints into a perfusion-only signal. If you are setting up a full perfusion model (where you model the full alternating tag/control timeseries in the design matrix) then you should not use this option. The subtraction results in a temporal shift of the sampled signal to half a TR earlier; hence you should ideally shift your model forwards in time by half a TR, for example by reducing custom timings by half a TR or by increasing the model shape phase by half a TR. When you select this option, FILM prewhitening is turned off (because it is not well-matched to the autocorrelation resulting from the subtraction filter) and instead the varcope and degrees-of-freedom are corrected after running FILM in OLS mode. See the Perfusion section of the manual for more information.

Highpass: Tick this option

Highpass temporal filtering uses a local fit of a straight line (Gaussian-weighted within the line to give a smooth response) to remove low frequency artefacts. This is preferable to sharp rolloff FIR-based filtering as it does not introduce autocorrelations into the data. 

Lowpass: un-ticked (not selected)

Lowpass temporal filtering reduces high frequency noise by Gaussian smoothing (sigma=2.8s), but also reduces the strength of the signal of interest, particularly for single-event experiments. It is not generally considered to be helpful, so is turned off by default. By default, the temporal filtering that is applied to the data will also be applied to the model.

MELODIC ICA data exploration: un-ticked (not selected)

The MELODIC option runs the ICA (Independent Component Analysis) tool in FSL. We recommend that you run this, in order to gain insight into unexpected artefacts or activation in your data.

Setting up the General Linear Model

Select the Stats tab and press Full model setup to setup the GLM details.

Change the Number of EVs to 2 (we have two conditions to model separately - audio and visual).

Set up EV1 (the visual stimulation timing):

Set Off to 30
Set On to 30
Set Phase to 30
This describes a square wave of total period 60s. It starts with an ON period, hence the phase setting, which shifts the waveform forward in time.

Set up EV2 (the auditory stimulation timing):

Set Off to 45
Set On to 45
Set Phase to 45
Now set up the Contrasts:

Set the Number of contrasts to 2
Set the first (OC1) to [1 0] 

Set the second (OC2) to [0 1]

The first output colour overlay image produced will show visual activation as only EV1 is used, and the second will show only auditory activation. Note that you can give each contrast a title. So, entitle the contrasts "Visual" and "Auditory" accordingly.

Now set up the F-tests

Set the Number of F-tests to 1
Select both contrasts

Thus the third output colour overlay image produced will show where either visual or auditory activation occurs (i.e. will show both on a single image).

 Press View design. 

Make sure you understand the resulting design matrix. Time goes down the page, with every 10 TRs ticked off on the left. The red bar shows the width of the highpass filter (any signal much longer than it will get removed). There are 4 columns in the design (1 and 3 are the ones you just set up and 2 and 4 are temporal derivatives of 1 and 3 - this will be explained in a later talk). The contrasts appear at the bottom of the image, with the F-test to the right of the contrasts. Note, that you can make the design matrix display disappear just by clicking on it once. For now, leave the design matrix display up (Press View design again if necessary).

 Now, return to the EVs tab and FOR BOTH EVs:

Change Convolution from Gamma to None
Deselect Apply temporal filtering 

Deselect Add temporal derivative.

 Press View design and note how you are now viewing the underlying conditions that were entered.

 Restore the original settings one step at a time FOR BOTH EVs, viewing the design after each change (change Convolution to Gamma, then select Apply temporal filtering, then select Add temporal derivative). Make sure you understand the changes in the design matrix and their importance.

 When you are happy that the design matrix is restored, press Done.

Setting up post analysis statistics and thresholds

For the purpose of this tutorial we will leave the default settings of the program as they are.- cluster-based thresholding will be carried out. Read the detail below or go straight to the next section: Registering EPI to High resolution to standard data

If you choose a mask for Pre-threshold masking then all stats images will be masked by the chosen mask before thresholding. There are two reasons why you might want to do this. The first is that you might want to constrain your search for activation to a particular area. The second is that in doing so, you are reducing the number of voxels tested and therefore will make any multiple-comparison-correction in the thresholding less stringent. The mask image chosen does not have to be a binary mask - for example, it can be a thresholded stats image from a previous analysis (in the same space as the data to be analysed here); only voxels containing zero in the mask image will get zeroed in this masking process. If pre-threshold masking is used, it is still necessary to carry out thresholding.

Thresholding: After carrying out the initial statistical test, the resulting Z statistic image is then normally thresholded to show which voxels or clusters of voxels are activated at a particular significance level.

If Cluster thresholding is selected, a Z statistic threshold is used to define contiguous clusters. Then each cluster's estimated significance level (from GRF-theory) is compared with the cluster probability threshold. Significant clusters are then used to mask the original Z statistic image for later production of colour blobs. This method of thresholding is an alternative to Voxel-based correction, and is normally more sensitive to activation. You may well want to increase the cluster creation Z threshold if you have high levels of activation.

The FEAT web page report includes a table of cluster details, viewed by clicking on the relevant colour-overlay image. Note that cluster p-values are not given for contrasts where post-threshold contrast masking (see below) is applied, as there is not a sensible p-value associated with the new clusters formed after masking.

If Voxel thresholding is selected, GRF-theory-based maximum height thresholding is carried out, with thresholding at the level set, using one-tailed testing. This test is less overly-conservative than Bonferroni correction.

You can also choose to simply threshold the uncorrected Z statistic values, or apply no thresholding at all.

Contrast masking: You can setup the masking of contrasts by other contrasts; after thresholding of all contrasts has taken place you can further threshold a given Z statistic image by masking it with non-zeroed voxels from other contrasts.

This means that of the voxels which passed thresholding in the contrast (or F-test) of interest, only those which also survived thresholding in the other contrasts (or F-tests) are kept.

As a further option, the generated masks can be derived from all positive Z statistic voxels in the mask contrasts rather than all voxels that survived thresholding.

Rendering: The Z statistic range selected for rendering is automatically calculated by default, to run from red (minimum Z statistic after thresholding) to yellow (maximum Z statistic). If more than one colour rendered image is to be produced (i.e., when multiple constrasts are created) then the overall range of Z values is automatically found from all of the Z statistic images, for consistent Z statistic colour-coding.

If multiple analyses are to be carried out separately, Use preset Z min/max should be chosen, and the min/max values set by hand. Again, this ensures consistency of Z statistic colour-coding - if several experiments are to be reported side-by-side, colours will refer to the same Z statistic values in each picture. When using this option, you should choose a conservatively wide range for the min and max (e.g., min=1, max=15), to make sure that you do not carry out unintentional thresholding via colour rendering.

With Solid colours you don't see any sign of the background images within the colour blobs; with Transparent colours you will see through the colour blobs to the background intensity.

If you are running a Higher-level analysis you can select what image will be used as the background image for the activation colour overlays. The default of Mean highres is probably the best for relating activation to underlying structure. For a sharper underlying image, (but one which is not so representative of the group of subjects), you can instead choose to use the highres image from the first selected subject. You can alternatively choose to use the original lowres functional data for the overlays, or the standard-space template image.

Registering EPI to High resolution to standard data

Select the Registration tab. 

By default FEAT will register the middle timepoint image (saved as example_func in the .feat output directory) from the 4D FMRI input data directly to the standard space template. 

Turn on the Initial structural image, Main structural image and Standard space options

The lowres FMRI image is first registered to a brain-extracted highres structural image from the same subject acquired with the same spatial dimensions and slice thickness (a T1 FLAIR image at YNiC); this is then registered to a whole-head 1*1*1mm isotropic T! for the individual. This highres is then registered to the standard space template, and then the three registrations are combined to give an example_func2standard.mat transform which will be used later to resample the FMRI stats into standard space.

Select Initial structural image, set the file to epiwholehead.hdr and set the DOF to 3 

We only have a few slices in the timeseries data which correspond to certain slices in the epiwholehead image, we do not want to allow the image to be rotated. 

Set the Main structural image file to structural_brain.hdr with 7 DOF 

Note that we have already run BET on this.

Leave Standard space turned on with avg152T1_brain.hdr selected and set the DOF to 12.

Running the FEAT analysis

You are now ready to run FEAT. 

You would normally press Go.  DON’T!
When at YNiC however, you do not need to slow down the computer you are working on by running FEAT locally. You also may want to set the analysis running and then leave for the night – to return and look at the results the following day. In this case we don’t want you to have to leave the computer logged in overnight. 

You can send your FEAT job to the cluster by doing the following:


Create a directory in your scratch space for the results



You can either:

Navigate to the directory in Finder, highlight the  folder with a left mouse click, select File > New Folder, then rename the folder something sensible – we suggest my_feat_tutorial




Or:





At the command line type: 





> mkdir  ~/scratch/my_feat_tutorial

Now Click back on the Feat window. 

With your full model set up you can save the session’s setting (all the details you just set up). At the bottom of the Feat window Click Save.

Select to the directory you just created.

Once the directory is selected, append /av to the end of the file path in the Selection window.

The window should now show:

/scratch/home/myname/my_feat_tutorial/av

Now click OK to save the settings to

/scratch/home/andre/my_feat_tutorial/av.fsf

Using Finder, check the directory you created for your setting and results. The following files should have appeared in the directory:

test_cov.gif

test_cov.ppm

test.con

test.fsf

test.gif

test.grp

test.mat

test.ppm
Using the command line, navigate to the directory you just checked. Type: 

 > cd /scratch/home/myname/my_feat_tutorial/
Now send the .fsf file setting to the cluster using the command. Type:

> clusterFeat –f av.fsf
if successfully submitted, your terminal should say:

Your job 252963 ("FEAT") has been submitted

Viewing the results of your FEAT analysis:

With Finder navigate to your results directory .. or for the purposes of this tutorial:
/scratch/groups/tutorials/mri/fsl_course_results/av_fmri/av.feat

Double click on report.html. 

The report output page should load in a Web browser.

Look carefully at the various elements of the page, including motion correction plots, colour-rendered activation and registration results. Note that if you click on the activation images you get a table of cluster co-ordinates.

Tutorial 2 – fMRI data analysis using FEAT – within group (or between subjects) analysis 

________________________________________________________________

This tutorial leads you through an example of higher-level group analysis in FEAT using a paired t test to analyse within group variance.

We have a group of 6 subjects scanned under two different conditions, A (left hand motor function) and B (right hand). Is there a significant A-B paired difference generalisable to the population from which the subjects are drawn?

We want the A-B paired mean difference within a mixed effects model, taking into account the within-subject fixed effects variances and the between-subject random effect variance. This is done as a two-level analysis:

· Level 1: Single-session analyses; there are [6 subjects] * [2 sessions] = 12 first-level FEAT analyses. These have already been done for you.

· Level 2: Between-subject analysis; we input the COPEs from Level 1 (there are 5 contrasts at Level 1 and hence 5 separate second-level analyses), and estimate the paired difference mean for each. 

Note that as well as the COPEs, FEAT passes the variance of these COPEs ("varcopes"), and even the uncertainty in the variance of these COPEs ("tdofs" - degrees-of-freedom), between the different levels.

The first level analyses are held in 6 different directories in ~/fsl_course_data/fmri/ptt, one for each subject. The subject directories are ac, at, cm, df, dn and eg. Within these are the first-level FEAT directories, which have already been run for you.

Each first-level analysis contained 5 contrasts ("index", "sequential", etc.). Thus there are 5 copes in the stats subdirectory of each first-level .feat directory. The higher-level analysis will be carried out independently on these contrasts, i.e. a second-level analysis of all subjects' first-level "index" contrasts, a separate second-level analysis of all first-level "sequential" contrasts, etc. Each of these second-level analyses will form a separate cope**.feat directory inside a newly-created .gfeat directory.

· cd ~/fsl_course_data/fmri/ptt

· Type Feat_gui &

· Change First-level analysis to Higher-level analysis

· Change the Number of inputs to 12 (6 subjects * 2 conditions)

· Press Select FEAT directories. 

· Now, you need to fill the first level FEAT directories in a sensible order. You could either 

· select them in order:

· .../ac/ac_left.feat .../ac/ac_right.feat .../at/at_left.feat (etc.)

· or you could enter all the "lefts" first and then all the "rights":

· .../ac/ac_left.feat .../at/at_left.feat .... .../ac/ac_right.feat (etc.)

      We recommend the latter, because this matches the example paired t-test in the FEAT manual, and also matches the way the paired t-test is setup for you if you use the "model setup wizard" (explained below).

      Note that you can often avoid having to tediously hand-select each of these first-level FEAT directories separately, using the Paste button. If you press this, a new free-text window comes up, within which you can paste text (in this case the list of first-level FEAT directories) which you can copy, e.g. from a list in a terminal. Press Clear to clear the text window. Then in your terminal, inside the ptt directory, type

      echo `pwd`/??/??_left.feat `pwd`/??/??_right.feat

      This gives you a complete listing of the full pathnames of the FEAT directories in the right order. (The `pwd` part tells the shell to replace what's within the quotes with the result of running the command - in this case, filling out the full pathname of the current directory. The ? characters are expanded by the shell to fit any single character, in alphabetical order, hence all the "left" FEAT directories are listed first, and then all the "right".) You can now highlight this list with the mouse, and paste it into the FEAT paste window with the middle mouse button.

    * When this is done, set the Output directory to ~/fsl_course_data/ptt/ptt_ols.gfeat

    * Go to the Stats tab and select the Mixed Effects: Simple OLS option. Normally, we recommend that you use one of the more accurate FLAME options, for the reasons outlined in the lecture. However, in the interest of speed, in this practical we choose the faster OLS option.

    * With this design you can use the Model setup wizard, which provides an easy way of setting up a few simple designs. Select two groups, paired and press Process. You will now see the design matrix that has been created for you. To understand how this is controlled in detail, open the Full model setup.

      Note that the Inputs (1-12) must correspond to the order you entered the first-level FEAT directories. Also note that the first column (labelled Group) corresponds to groupings of inputs that will share the same random effects (RE) variance in this level of the model. Here, we let all subjects have the same RE variance (i.e. the Group column should be left as all 1s)

      There are 7 EVs:

          o EV 1 models the A-B (left-right) paired difference

          o EVs 2-7 are confounds which model out each subject's mean (this is what makes the design a paired t test) 

      Click on the Contrasts & F-tests tab. There are two contrasts setup for you by the wizard. EVs 2-7 are confounds of no interest and so do not appear in the contrasts. Hence, the contrasts only involve EV1. Change the Titles to read:

          o left > right

          o right > left 

    * Press Done.

    * The default Post-stats are fine. So you are now ready to run the analysis. Press Go, and wait for the results - this second-level analysis should take about 5 minutes. The web browser that appears monitors the overall progress.

    * Higher-level FEAT runs produce .gfeat directories. The top-level web report provides links to the previous level reports, a registration summary page (have a look at this, you may later need to reload the page if you view it before it's completed) and to the separate higher-level reports. LOOK AT YOUR DATA - in particular it is always important to look at the registration summary report page very carefully, to check that all lower-level registrations succeeded. (If any of the lower-level FEATs look like the registration has failed badly, you need to fix this before re-running the higher-level FEAT. The simplest way to do this is to start the FEAT GUI, change Full analysis to Registration only, select the first-level FEAT directory with the problematic registration and change the registration settings. The first thing to try is to reduce the search to No search (assuming that the data is roughly oriented correctly) and/or to change the DOF.)

    * If you get spare time at the end of this session, there are two other analyses of interest:

          o In the FEAT GUI, load in the design.fsf from the .gfeat directory. Change the modelling/estimation method to Mixed Effects: FLAME 1, which is nearly as accurate as full FLAME and nearly as fast as OLS. Change the output directory name to reflect this option. Under the Data tab, deselect all of the lower-level copes except 2 - this tells the group FEAT to only run the second-level analysis on the second of the first-level contrasts, not all 5. After completion (5-10 minutes), compare with the previous OLS results. The FLAME results do look "nicer", as well as there being some new plausible activations that were not previously found.

          o Whilst the above is running, get another analysis ready to run - revert to the OLS option, and change the model to the simpler unpaired t test (use the wizard, and make sure that you understand the EVs and contrasts that the wizard sets up for you), re-run and compare with the paired t-test results. 

Tutorial 3 – fMRI data analysis using FEAT – between group analysis

________________________________________________________________

Group difference with multiple sessions for each subject

We have a set of data which consists of two groups: patients and controls. Within each group we have 5 subjects. For each subject we have 3 sessions of the same experiment. Is there a significant difference between the means of the patient group and the control group, which is generalisable to the populations from which the subjects are drawn?

We want the mean group difference, across subjects, within a mixed effects model, taking into account the within-subject fixed effects variances and the between-subject random effect variance. This is done in THREE levels:

    * Level 1: Within-session analysis (there are [2 groups] * [5 subjects] * [3 sessions] = 30 of these first level FEAT analyses, which have already been done for you)

    * Level 2: Between-session analysis (in which we input the data from Level 1, and estimate each subject's mean response)

    * Level 3: Between-subject analysis (in which we input the data corresponding to the subject means from Level 2, model the between-subject variances and estimate the group mean difference) 

Because each subject only has 3 sessions, we do not run a completely separate second-level analysis for each subject - one reason for this is that we would not be able to get a good estimation of the within-subject session-to-session variance with just 3 sessions. Hence we put all the second-level analyses into a single second-level model and perform a fixed effects analysis to get separate estimation of each subject's mean response. See here for a discussion of the choice of a fixed effects analysis.

The first-level analyses are held in the directories ~/fsl_course_data/fmri/3lev/patients and controls. Within these directories are a directory for each subject, each containing the three first-level FEAT directories which have already been run for you. So, let's start with the level 2, within-subject analysis

    * cd ~/fsl_course_data/fmri/3lev

    * Type Feat &

    * Change First-level analysis to Higher-level analysis.

    * Change the Number of inputs to 30 (2 groups * 5 subjects * 3 sessions).

    * Press Select FEAT directories. Now, you need to fill the first level FEAT directories in a sensible order: control subject 1 sessions 1, 2, 3 then control subject 2 sessions 1, 2, 3, etc., followed by all the patient sessions. You can use the following command in the terminal to create the list to paste into the Paste window:

      echo `pwd`/*/*/*.feat

    * Set the Output directory to ~/fsl_course_data/fmri/3lev/lev2.gfeat

    * Go to the Stats tab and select the Fixed-effects option.

    * Press Full model setup. Note that the Inputs (1-30) correspond to the order you entered the first-level FEAT directories. As this is a FE analysis the Group column is ignored so leave all these entries as 1.

    * We need 10 EVs - one for each subject mean. Change the 0s to 1s appropriately, in such a way that each EV models a different subject mean. If you are not sure that you are doing the correct thing then ensure that your design matrix looks the same as the one shown below.

    * We now need to setup the contrasts. We need to pass the 10 parameter estimates (PEs) corresponding to the 10 subject means through to the third level as COPEs. To enable this , we need to have a contrast for each subject mean that just selects that parameter. Use the design matrix shown below for guidance.

    * Press Done and ensure that the design matrix is the same as:

    * The default Post-stats are fine (in fact the post-stats don't affect what gets passed up to third-level). So you are now ready to run the second-level analysis. Press Go, wait for the result web pages and then view them carefully. 

We are now ready to setup the third level, between-subject, analysis.

    * Type Feat &

    * Change First-level analysis to Higher-level analysis

    * Change Inputs are lower-level FEAT directories to Inputs are cope images (the inputs will be the 10 cope images, one for each subject mean, from the second-level analysis).

    * Change the Number of analyses to 10 (2 groups * 5 subjects = 10 copes from level 2, each corresponding to a subject mean)

    * Press Select cope images and enter the COPEs from the second level in order from 1-10. This ensures that 1-5 correspond to controls and 6-10 correspond to patients. These will be inside the cope1.feat/stats directory which is inside the second-level .gfeat directory that you just created.

      The relevant command for pasting the list is

      echo `pwd`/lev2.gfeat/cope1.feat/stats/cope?.nii.gz `pwd`/lev2.gfeat/cope1.feat/stats/cope??.nii.gz

      Can you see why this needs two separate parts, one with a single '?' and one with two?

    * Set the output directory to lev3.gfeat

    * Go to the Stats directory and, again to save time, select the OLS option.

    * You can use the wizard to setup a two groups, unpaired analysis (make sure the "Number of subjects in first group" is set appropriately). Note that the Inputs (1-10) correspond to the order you entered the second level COPEs. Here, the control subjects are modelled with one RE variance and the patient subjects with a different RE variance (i.e. Rows 1-5 of the Group column should be 1 and Rows 6-10 should be 2). The two EVs model the different means for the different groups.

    * However, instead of this model, let's first try and set it up another way. We still have two EVs, but now one EV represents the overall mean of both groups, and a second EV represents the difference between the two group means. This can be done using EV1 = [1 1 1 1 1 1 1 1 1 1]' and EV2 = [1 1 1 1 1 -1 -1 -1 -1 -1]'. Set up these two EVs.

      Do you think there is anything wrong with setting the design up in this way?

      Press View Design and you will see that there is indeed a problem with setting the design up this way. We have a design matrix that is not "separable" with respect to the variance groupings.

      We are trying to set up a design with different RE variance groupings for the control subjects and patient subjects. However, within each EV, inputs from only one of the variance groups can have non-zero values. We have violated this here.

    * So, to be able to have these variance groupings we must setup the design using EVs which are separable with respect to the variance groups. For this we need a different EV for each group mean. Re-run the wizard to go back to the recommended unpaired t-test.

    * We now have the following contrasts:

          o C1: "controls-patients" [1 -1]

          o C2: "patients-controls" [-1 1]

          o C3: "controls" [1 0]

          o C4: "patients" [0 1] 

    * Go to Post-stats. Reduce the Z threshold to 1.7 (with this artificially small number of subjects the effect is weak!). The other defaults are fine. So you are now ready to run the third-level analysis; press Go. 

This is the end of the Multi-level FEAT practical. In the second part of this practical, when you checked the second-level analysis results, did you notice that one or more of the first-level registrations (that we had already run for you) had failed? If not, you need to LOOK AT YOUR DATA!!

Tutorial 4 – fMRI data analysis using FEAT – advanced tricks ad techniques for efficient interrogation of initial results

________________________________________________________________

We have been trough the bog standard approaches to data analysis in FEAT for individuals and across / within groups. 

Whilst these processes are pretty straight forward to follow, they can take considerable amounts of time. You will be glad to know that that there are some nice tools available with FSL to make our data interrogation / interpretation quicker after an analysis has been run. Typical applications of these tools would include:

· Re-running the analysis without having to repeat all the previous steps and explore the effects of:

· Changing the stringency of the thresholding level (for statistical significance) 

· Compare cluster, voxel and uncorrected analysis approaches

· Correcting faulty co-registrations

· Adding registrations to additional coordinate spaces

· Viewing the effects of data pre-processing (de-noising, re-alignment, global intensity normalisation, etc.) on the raw time-series of 4D data

· Looking at activity (and the related statistical relevance) of restricted regions of interest

· Extracting model fit statistics for specific time series and regions

· Extracting the average time series for an activation cluster

· Moving between low, standard and high-resolution spaces – ApplyXFM_gui

Viewing ‘raw’ timeseries data

You can use fslview to view the raw timeseries of the data you have put into the analysis.

Launch fslview from the command line. Type:

 > fslview

Once the program has launched click on the File dialog on the top menu
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Load the fMRI data file you input into the av – analysis in Tutorial 1.

This can be found at:

/scratch/groups/tutorials/mri/fsl_course_data/fmri/av/fmri.nii.gz
The window will load the data:
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Once the dataset launches, go to the program menu and select:

View > Timeseries

A second window will open in the application window. It will display a line representing the time series of the signal change in a specific voxel over time.
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Resize the windows so that you can see the EPI volume and the time series window side by side.

Now click in the EPI data and move the mouse around. You will see that as you move over a specific voxel the time series window updates to reflect the temporal signal change for the voxel you are currently hovering over.

For an example of a voxel which reflects activity in the visual cortex in response to the stimulus change the current slice number (see red circle on image above) to 34 – 10 – 1 .

For an example of a voxel which reflects activity in the auditory cortex in response to the stimulus change the current slice number (see red circle on image above) to 47 – 27 – 2 .

Since this is a multiple volume dataset, you can scroll through the volumes in order. Either click the volume number scroll button (see blue circle on image above) and cycle through, or click the movie icon on the menu bar. This will cycle through all volumes in sequence. Click again to stop.
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Notice the signal changes in the volumes as they cycle. If you look carefully at the edges of the volumes you should also be able to see movement in the position of the head (especially if you use the volume number scroll button to alternative between the first (0) and last (44) volume. 
Now Quit fslview
Re-launch fslview as described before, but this time load:

/scratch/groups/tutorials/mri/fsl_course_results/av_fmri/av.feat/filtered_func_Data.nii.gz

This dataset is the same dataset as you loaded before, except for the fact that FSL has pre-processed the data as instructed in the pre-stats page of FEAT (motion correction, pre-whitening, etc.).

View the data as before. Notice that the data does look ‘smoother’ (as we may well expect) and that there appears to be less movement around the edges of the volume.

Creating region of interest masks (manually)

Sometimes you will want to restricts the statistics and interpretation to regions of interest. These are usually:

· Anatomically defined locations in standard spaces (e.g. a region defined as the hippocampus in the MNI brain)

· Functionally guide placement of regions of interest – just look at the activity of voxels included in a single blob (of multiple) in a statistical z map (i.e. my z map shows lots of separate clusters, just show me the results for the ones in visual cortex)

Open the following file with fslview as described before:

/scratch/groups/tutorials/mri/fsl_course_results/av_fmri/av.feat/example_func.nii.gz

Once it has loaded, overlay the z-stat image for the visual stimulus over it. Click 

File >  Add 

And then select the following file:

/scratch/groups/tutorials/mri/fsl_course_results/av_fmri/av.feat/thresh_zstat1.nii.gz

The z-stat image should be overlaid on the epi volume:
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We will now use FSLView to create a hand-drawn mask in standard space that will be used later to find out about activation statistics from within the mask. Choose an area of interest - for example, left visual cortex (see the red circle above).

Create an editable mask image with the same dimensions as the EPI space template, by pressing:

File > Create Mask.

Move the cursor around until you are in the middle of the visual cortex.

Turn on "drawing mode" by pressing the button with the pencil icon. 
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The menu will now have some extra functions available:
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Increase the pencil drawing width by increasing the value in the textbox at the far right end of the voxel co-ordinate boxes, for example, to 3. 

Click and drag over a region of the brain roughly corresponding to the visual cortex, in the axial view. 

Whenever you let go of the mouse button the region you have been drawing will get filled in on the mask overlay image.

You could move up to the next slice using the up arrow next to the Z co-ordinate box, and do that one as well if you wanted.

When you have drawn the mask in a few slices, save the mask image to file: Make sure the mask is selected (highlighted) in the image list, and then press: 

File -> Save. 

Save the file to the following location:

/scratch/groups/tutorials/mri/fsl_course_results/av_fmri/my_mask.nii.gz

Understanding masks and masking (..and coordinate spaces!)

The mask we just created is a binary mask – i.e. it was the value of 1 in positions we ‘kept’ (regions of interest) and the value of 0 (zero) where we aren’t interested. The graphical and mathematical descriptions can be seen below.

Similarly, our image we apply the mask to is a set of intensity values at a set of different locations. This image however is not binary (0/1) .. it has values of different intensities (just like MRI data!). 

Despite the range of image values, we can apply the mask to the image data as long as the dimensions and resolution are the same (think of this as the pictures are the same size and the pictures are cut up into equal numbers of blocks all of equal size).

The graphical interpretation of how masking works:






Using created masks

Once you have created masks of regions of interest you can apply them to structural or statistical result datasets with the same resolution and dimensions (this should be clear if you have read the previous section).

See XXXtranformations later to find out how to change a mask so that it can be used with data in other coordinate spaces (e.g. a mask created in EPI space can be easily transformed to be in standard or an individual’s  high resolution space without having to manually create new masks). 
This can be done:

· Manually applying a mask to an existing z-stat file

· Using FeatQuery to interrogate the data for you.

Manually applying masks:

If you have read the previous section you will understand that applying a mask means multiplying it by the image.

As such, we can use the simple maths tools (avwmaths) supplied with FSL to do this.

Apply the mask we created before to the visual z-stat image. The commands are used as follows:

> avwmaths imagefile –mul maskfile outputfile
this means : use avwmaths  .. on an image ... multiply it … by a mask … as save as a new output file.

So, for our example we would type: (on a single line)

> avwmaths /scratch/groups/tutorials/mri/fsl_course_results/av_fmri/av.feat/thresh_zstat1.nii.gz –mul /scratch/groups/tutorials/mri/fsl_course_results/av_fmri/my-mask.nii.gz /scratch/groups/tutorials/mri/fsl_course_results/av_fmri/av.feat/my_masked_thresh_zstat1

As at the start of this section, load fslview and open :

/scratch/groups/tutorials/mri/fsl_course_results/av_fmri/av.feat/example_func.nii.gz

Now overlay your masked statistic image . Press:


File > Add

And then select:

/scratch/groups/tutorials/mri/fsl_course_results/av_fmri/av.feat/ my_masked_thresh_zstat1.nii.gz

Notice now how there is only statistical data for the left visual cortex displayed (load 

/scratch/groups/tutorials/mri/fsl_course_results/av_fmri/av.feat/thresh_zstat1.nii.gz to compare if you like).

Moving between low, standard and high-resolution spaces

What is we now want to see out previous result in standard or high-resolution space?

GOOD NEWS! -  you don’t have to repeat the whole previous process to create an equivalent mask for the  area in the high resolution or standard brains (spaces).

When you co-registered earlier in FEAT, the transformation values you need to make these conversions were worked out for you. The list can be browsed at:

/scratch/groups/tutorials/mri/fsl_course_results/av_fmri/av.feat/reg

This folder contains a number of files including:

example_func2highres.mat

example_func2initial_highres.mat

example_func2standard.mat

highres2example_func.mat

highres2initial_highres.mat

standard2example_func.mat

standard2highres.mat

etc.
These files are transformation matrices: mathematical descriptions of what needs to be done to one set of data in its own coordinate space to be transformed into another dataset’s different coordinate space:

e.g. applying example_func2standard.mat to a dataset in the same coordinate space as the functional data (like out newly masked stat data) will move the data into a coordinate space which will be meaningful for comparison with and overlay on the standard brain.

A tool which allows you to do this is the ApplyXFM_gui: at the command line type:
> ApplyXFM_gui

[image: image10.png]6066 [X] ApplyXFM

Input
i Use dentfy transformation 1 Apply inverse transformation

Transformaian Malrs =
Input Valume (3D ar 4D) =
Oufput Size

Base on:  Existing Volume —

Reference Volume =
Output

g =

> Advanced Options

oK Apply Exit





The new window will pop up.

Transformation Matrix: 

Select:

 /scratch/groups/tutorials/mri/fsl_course_results/av_fmri/av.feat/reg


example_func2standard.mat

Input Volume (3D or 4D): This is the file we are changing into a different space.

Select: 

/scratch/groups/tutorials/mri/fsl_course_results/av_fmri/av.feat/my_masked_thresh_zstat1.nii.gz

Reference Volume: This is the file who’s coordinate space we want to move into. 

Select: 

/scratch/groups/tutorials/mri/fsl_course_results/av_fmri/av.feat/example_func.nii.gz

Output Volume: create a new file that is our current file converted into the new coordinate space. 

Select: 

/scratch/groups/tutorials/mri/fsl_course_results/av_fmri/av.feat/my_thresh_zstat1_in_standard.nii.gz

Click Apply
As at the start of this section, load fslview and open :

/scratch/groups/tutorials/mri/fsl_course_results/av_fmri/av.feat/example_func.nii.gz

Now overlay your newly transforme, masked statistic image . Press:


File > Add

And then select:

/scratch/groups/tutorials/mri/fsl_course_results/av_fmri/av.feat/ my_thresh_zstat1_in_standard.nii.gz

Of course you can use any combination of matrices to move objects you create in one space to any other with the transformation matrices in the reg folder. Just be careful that you:

(1) know which space you are currently in

(2) know which space you want to go to

(3) pick the correct transformation matrix to convert 

(4) overlay your new file on the correct image when you’re done

Re-thresholding statistics

Using Featquery

Whilst FEAT is running, run fslview to have a quick look at the different images mentioned above: start with

fslview epiwholehead.hdr

      then exit this and view structural_brain.hdr and finally exit this and view fmri.hdr. Note that when viewing the 4D image you can see the image time series as a movie by pressing on the movie icon, and can also see time series plots by pressing View->Timeseries then Windows->Tile then positioning the cursor before pressing the + in the time series view.

 Again; whilst FEAT is still running, 

Re-thresholding

You can re-run thresholding on the FEAT run that you have just created very easily.

    * Start the Feat GUI. Change Full analysis to Post-stats. Select the Data tab and press Select FEAT directory and select fmri.feat. Go to Post-stats and try a different thresholding option - maybe try voxel-based thresholding with the same P threshold as before (0.01).

    * Select the Registration tab and deselect all registrations so that none occur, as there is no need to repeat them.

    * Select the Misc tab and change Overwrite original post-stats results to Copy original FEAT directory for new Post-stats/Registration, as we want to be able to compare the new results to the old.

    * Then press Go. A new FEAT directory will get created (fmri+.feat); compare these results to the original run. (Note that before pressing Go you will need to press Edit contrasts on the Post-stats tab, and press Done again - this is to make sure you are happy with the set of contrasts you are running.)

    * If you get time at the end of this session try running a range of threshold types and settings to see their effect. You could also try changing the preprocessing options - for example, how much worse is the activation if you do not run motion correction? 

Featquery

Featquery allows you to calculate certain data statistics, either at a voxel of interest, or averaged over a region of interest using a mask. We will use the standard-space mask vismask.hdr which we created earlier.

    * Start Featquery by typing Featquery &

      (Featquery_gui &     on Mac/Windows)

    * Select the fmri.feat directory from your first analysis on the audio-visual dataset. On Mac you might need to expand the window after selecting the FEAT directory.

    * Featquery automatically reads the FEAT directory and gives you the appropriate options as to which statistics you want summarise. Select the following statistics to summarise:

          o stats/cope (unthresholded contrast of parameter estimate)

          o stats/zstat (unthresholded z statistics)

          o stats/tstat (unthresholded t statistics)

          o thresh_zstat (thresholded z statistics) 

    * We could also look at the average time series for the region of interest by selecting the filtered_func_data option. This is saved as a text file in the featquery output directory inside the chosen Feat directory.

    * Select the Convert PE/COPE values to % option

    * Select vismask.hdr as the Mask Image (note - Featquery can take either a standard-space mask OR a lowres one in the original dataspace OR a mask in the space of the structural image)

    * Press Go and the statistics are produced. If your standard space visual mask is any good, the mean value for the visual zstat image should be a lot larger than for auditory! 

High-resolution Single-Session Overlays

You might want to see your low resolution data overlaid onto your high resolution image. Use the Renderhighres gui and select your FEAT output directory. Select the Do rendering in Talairach space option and also select the Keep 3D files option (otherwise you will just end up with 2D picture files at the end). When the processing has finished you can find the rendered_hr_*.hdr pictures in the FEAT directory and view them with fslview. This takes a few minutes, as the images get resampled into high resolution using accurate, but slow, sinc interpolation method; whilst you are waiting you should start a new terminal and move on to the next section.

Custom Waveforms

We can load more complicated EVs into FEAT using Custom Waveforms. Here, a dataset has been generated with some more complicated single-event conditions to model.

Overlay this mask 


(a bit like a window)





The image


(Mask goes over this)





Leaves this


(The masked image)





Mathematically this means multiplying the mask by the image to give us the masked image.


Top left of mask (=0) multiplied by top left of image (=0) gives top left of masked image (=0) 


Top right of mask (=0) multiplied by top right of image (=4) gives top right of masked image (=0)


Middle of mask (=1) multiplied by middle of image(=3) gives middle of masked image (=3)
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Two things should be clear from this example:


Applying a mask is basically nothing more than multiplying one array by another


It would make no sense to apply a mask of certain dimensions and/or resolution to an image with different dimensions and / or resolution (think of a 10cmx10cm square with 1cm blocks overlaid onto a 20cm x 2cm rectangle made up of 2cm blocks)








